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Further information and descriptions are available in the relevant documentation Graphical input (description
of the basic functions). In addition to the individual program manuals, you will find basic explanations on the
operation of the programs in the document Basic operating instructions-PLUS_eng.pdf.
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Application options

Typical buildings in solid construction are considered as complete load-bearing structures. You can enter data
via a graphical user interface, which you might know from the slab application PLT. You can import DXF files
from CAD applications for each floor and use them as floor plans.

The data are recorded for each floor with all load-bearing components:
Floor slabs with different areas (supporting direction, thickness, foundation and reinforcement areas)
Walls (material, wall thickness)
Columns
Beams
Parapets

A chain of walls with several sections of the same material is considered as a uniform wall pillar, unless
otherwise defined by the user.

The software application assumes a "standard floor" with all typical constructive properties. After the
definition of the floor, the user can copy it to create the next one. Optionally, the user can define a different
floor plan for each floor or import a floor plan from a CAD application.

The details of each floor can be edited.

The foundations can be dimensioned by specifying the permissible soil pressure and the minimum
dimensions and projections.

Pre-design

= Fast calculation of loads for the foundations

Well-structured representation of the load transfer, even in complex buildings
= Inclusion of the calculation of stiffeners for horizontal loads

= Pre-design of the load-bearing components (beams, walls, columns and foundations) and determination of
the cross-sections in the first design phase

Final design

= Representation of the loads suitable for review, loads are shown separately for each floor and component
as G, P and full loads

= Direct transfer of data to the software applications for the design of the individual components

Reinforcement drawings

= The As-values (FE plate) or the reinforcement layout can be exported from the design applications to CAD
programs (Allplot by Nemetschek AG, -isb cad- Glaser) to create reinforcement drawings quickly and easily.
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GEO-HL: Horizontal load transfer

With the optional additional module GEO-HL, horizontal loads from wind, inclination and earthquakes can be
determined. The wind loads can be calculated depending on the building geometry and the given wind
parameters. Inclination loads are automatically generated from the calculated vertical loads.

The distribution of the loads on the stiffening components takes place in relation to the bending stiffnesses. A
contribution to the horizontal load transfer can be defined both in groups (for example, reinforced concrete
walls only) or for individual components.

GEO-EB: Earthquake

Determination of earthquake loads according to DIN EN 1998-1 and DIN 4149, 6.2.2 for Germany and ONORM
B 1998-1: 2013-06/2017, 4.3.3.2 for Austria.

The determination of the earthquake loads takes place according to the simplified response spectrum
method.

I This module requires GEO-HL

GEO-ME: Quantity survey

The quantity determination is controlled via the output profile. This allows you to define the table output
individually for the individual materials and components as well as for individual floors or across the floors.
Also, the export as an Excel folder or CSV file is possible.

Reinforced concrete: Wind loads:
DIN 1045 / DIN 1045-1 New wind load standards DIN 1055-4 and
DIN EN 1992 EN 1991-1-4 (DIN, ONORM, BS)
ONORM B 4700 Materials for steel columns as per:
ONORM EN 1992 DIN 18800
UNI EN 1992 DIN EN 1993
BS EN 1992 ONORM EN 1993
PN EN 1992 BS EN 1993
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Basis of calculation

The bearing loads are calculated for each floor with the help of a FEM plate calculation and transferred to the
floor below.

Basic structural deformations are not taken into account.

The base of a wall pillar is in a constant stress state due to vertical loads. Therefore, a constant linear load
caused by these vertical loads is transferred to the next floor at the base of a wall pillar. This assumption is
allowed if the centroid of all loads on a floor slab is approximately identical to the centroid of the transferred
loads.

A first-order analysis is performed for state I.

As the calculation handles the individual floors from top to bottom, floor slabs suspended to the floor slab
above cannot be considered.

Wall-type beams over several floors cannot be taken into account either.

A bracing calculation is only available for non-sway systems, because the horizontal loads on each floor level
are split up according to the bending stiffness of the bracing components (see also chapter Horizontal loads.

The loads applying to the transferring components are determined with the help of the finite elements method
and not via load influence areas.

It should be noted in this connection that the typical particularities of this method at singularity points (e. g.
high shear force jumps at re-entrant corners) will occur also in this calculation. Comparative calculations with
3D-FE-applications show that normally the calculated loads differ less than 5 % from the accurate three-
dimensional calculation under normal conditions.
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Input

Graphical user interface

The GEO application offers a graphical user interface, i.e. elements such as slab outlines, load coordinates
etc. are drawn with the help of the mouse on the screen. Under normal conditions, you only need to enter
numerical values of forces, etc. in corresponding dialogs.

You can see the defined graphical objects immediately on the screen. The hide/display options for individual
elements such as load arrangements provide for a well-structured overview of even highly complex systems.

The graphical user interface itself is an independent application module, which is integrated with the GEO
application.

The functions of the graphical user interface module are described separately in the document
Graphical User Interface.pdf.

Numerical user interface

You can define values of course via numerical input fields each time a precise numerical specification is
needed or preferred.

Q[ 3os|@[ 5508 [  o000]mcs  num
Note: Direct help and support referring to the current input operation is given in the form of a short

comment in the status line on bottom left of the screen.

Importing data from CAD, PLT, WL, ASCII

Allplan
You can import geometrical data providing the basis for the system definition via GLiSER b ead
the DXF interface. Files of the -isb cad- application by Glaser can be processed EXF
directly. From Allplan, data of PLT Plates by Finite Elements can be imported into ;Ruo ASCH

the building model too. A prerequisite to this is that components have been used
in Allplan.

Floor Data from PLT-item

Load WL-Position

Plates can be imported from PLT and the building system can be imported from Load transfer from building item
the program WL - Windloads.
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Defining a building

The definition of a building starts with the floor slab of the first floor. It is entered by drawing or defining the
outline and the basic parameters.

The basic parameters are as follows: Material, slab thickness, top edge of floor slab, floor height, additional
permanent load, live load, concrete cover.

Various drawing functions are available for the definition of outlines, recesses, walls, columns, loads, auxiliary
lines etc. They are accessible via icons that can be activated per mouse click. There are icons for the input of
lines, rectangles, polygons and circles. The definition of these outlines, i.e. the input of decisive coordinates,
lengths and radii is done per mouse click under normal conditions. You can however always enter individual or
all coordinates numerically via the keyboard.

In the menu » Options » Basic building data, you can define the elevation of the top edge of the floor slab of
the selected floor. After this, you can select the desired standard for the load assumption. In the wind load
section, you can select the wind load zone and the terrain profile.

In the Loads menu, you can find the load case management, action groups, concentrated, line, area and
temperature loads as well as load transfer from an other GEO-item.

We recommend using the copying and editing functions for the efficient input of several floors.
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Floors

Floor levels

Access via the “=1 button or the "floor levels" menu item in the main tree.

In the "floor levels" dialog, the user can

- define

- copy

- delete

floor levels and edit the floor height, the floor slab thickness and the floor slab top edge.

The user can assign a hame to each floor in the "Name" column. Alternatively, you can assign names
automatically (first basement floor, ground floor, first floor, etc) via the "Name" button.

The floor number in the first column is generated automatically irrespective of the name. The user can edit the
floor numbers too.

The buttons in the section "Add new floor" allows the user to add additional floors above or below the
currently active floor (the currently active floor is that of the currently active row in the floor table). When
adding a new floor you are prompted whether to copy the data of the floor above or underneath. If you want to
import a new floor plan from a CAD application, select No in the prompt and activate the Import function to
load the new floor plan.

i= Floor Levels *
Floor Floor Upper edge Floor height  Slab thickness ™ .
No. Description ceiling [m] [m] [em] EIH: New floor upstairs
1 2 Floor 570 285 20.0 =" N.ew = ;bm_
0 1. Floor 2,85 2,85 20,0 =
+ -1 Basement 0,00 285 20,0 3«: Bazement floor
+ -2 Bottemplate -285 0,30 30,0 E

§:¢ Delete line

W o~ @b W=

W =K Delete all

=y Floor Description

Deleting floors

Activating the "Delete row" button, deletes the contents of the currently active row (the currently active floor).

Activating the "Delete all" button deletes all rows (floors).

Copying floors

See the chapter Floor selection.
Moving floors

ﬂ L With these buttons you can move the active floor up or down.
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Floor selection /copy

You can navigate through the floors of the building by using the floor selection
function.

Copy floor/generate new floor

You can define additional floors via "Next upper floor" or "Next lower floor". This
option copies the currently selected floor and displays the basic parameters
dialog. You have the option to copy the loads too.

To generate a new floor (which is not a copy of the currently active one), activate
the menu item "floor levels". The submenu options allow you to create and delete
floors.

Copy loadcases to other floors

You can choose loadcases to copy them from the currently selected floor &

into other floors.

om

-~ = Input horizontal loads

m Building with bottomplate (Project: Bu
2 File Edit Options Layout Wind
‘Damdl & a9 s
£ v_

Floor: 2. Floor

e upper
Flcmr: 2. Floor
Floor: 1. Floor
Floor: Basement
Floor: Bottomplate
i Floor: MNext lower

E-E-E-EB-E

Material list
[ Load case
[+] action groups
@~ + Pointload
¥+ Line Load
-1 AreaLoad
#- L Temperature Load
m Load transfer from building position
E Copy loads into other floors

Copy loads in other floors

~
L
]

Load cases, Floors,

to be copied where the loads are to be copied to
Load cases : Floor Levels

[1 LastfalG [l 3Floor

[1 Lastfana 2 Floor

] self weight ] Ground Floor

payload 1 [l Basement

payload 2

[1 Loadcase®

What should be done, if load with the same name already exist

W

(®) Copy Ioads in a new load case
O In addition copy loads (keep the existing loads of load cases)
O replace the existing loads of load cases with copied loads
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Foundation design - user-defined settings

The menu item » Defaults of foundation allows you to set parameters for the foundation design (permissible

soil pressure...) and the Elastic Bedded Beam BEB+ (Bedding module).

Specifications for foundation calculation

Material : 1. C20425 B500A w~ Material data

Admissible soil pressing kMim®
Minimum lateral overhang at the foundation 10:0:| =n

Minimum projection foundation over the wall end

Measure for broadening the strip foundations

Minimum projection foundation over the wall end

Winimum width foundation

Winimum height foundation

Winimum height of external foundation
Smallest area, covered by the foundation

Wall opening size, which is covered

[ Frost apron Width of the frost apron 200 em

Bedding module for Elastic bedded Beam (BEB+) S0000,00 | kN/m3

*

oK Cancel

The specified soil pressure and the calculated loads are used to determine the required dimensions of the
foundation. If these dimensions are smaller than the specified minimum dimensions, the minimum values are

used.

The actual foundation design is done in the respective foundation design software as with other components.
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Input loads for plate

The cross-program functions of the load input are described in the
document "Graphical input” in the chapter Loads. The Loads menu item
includes the load case management, action groups, point, line, area and
temperature loads.

Load transfer from building item

You can access this functionality via the main tree:

B Material list
-2 Input loads for plate
[N Load case
[+] action groups
+ Point load
4 Line Load
1l Area Load
¥ Temperature Load
{7 Load transfer from building position
31 Copy loads into other floors
= Input horizontal loads

BB

Input of loads for plate » Load transfer from building item or via the menu item

File » Import » Load transfer from building item

This function was developed for a situation close to practice when several sections of a building are built on a

common plate (basement or underground garage ceiling).

You can import the load on the individually calculated building items
into the currently active floor level (e. g. the common basement
ceiling) of the currently accessed building item.

A window for project and item selection opens.

The load transfer is only available for items including
calculated/stored results.

When importing, various options are available for vertical/horizontal
load transfer.

Import loads >

Accepting vertical load

O Summarized in: Load case GU, load case QU

@ Load case-specifically, from inner force azsembly

Accepting horizontal load

As a lead on the ceiling
[ As load cases of the H action
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Horizontal loads — additional option GEO-HL and GEO-EB

With the option GEO-HL horizontal loads can be determined from wind, inclination - in addition to GEO-HL the
additional option Earthquake GEO-EB can be purchased.

14t Base parameters

i= Floor levels
Access via the menu item » Input horizontal loads Defaults of foundation
Material list
The horizontal loads are distributed on the bracing components of each floor based ¥ Input loads for plate
on their bending stiffness. 37 Copy loads into other floors
i i i Input horizontal loads
For separate walls or wall pillers of one wall, the stiffness of the weak axis at the . Result sections
walls can be switched off in the menu under Options » H-Load distribution. % Schiick Isokorb®
JE HALFEN HIT insolation element
= Design Check in FRILO
Shear field stiffness is not taken into account. You should note in this context that 8 FE mesh
only non-sway buildings braced with walls can be calculated, because frame effects [Ty Remarks
cannot be taken into account in the software application. < >

Building joints:  If a continuous joint is planned in the building, the individual parts of Project 5 Input R

the building should be calculated separately in different models. If a
plate joint in a floor is entered as a complete joint, the user is informed of this requirement.

You can enter horizontal loads manually or generate wind loads and loads due to inclination automatically.

Input horizontal loads X
Lead case building
B ” Nr. Load case Active AG Al Grp.
o [
L) -
= " 1 Wind Wx B4 El 1 u, New
B p 2 Wind Wy 9 1
= 5 3 =h| Copy
i B 4 7
ivf L
" 5 34,6 2
= — B8 I+ Deleteline
E 7
g = 8
TRl o : g
o 10 = Wind
o5 0 I 5 1 r—
| = A 12 = Wind (+/-)e (10%)
! - 13 s Inclination
- 14
15 [=]  Earthquake
3 10,48 v 1,34 16
Horizontal loads
o Designation Upper Floor height Wx ¥ Wy x
" floors e"ﬂle ;“ﬂb [m] [kN] [m] [kN] [m]
m
1 2. Floor 5,70 2,85 34,60 5,21 0,00 0,00 = Generate Wind
2 1. Floor 2,85 2,85 40,66 521 0,00 0,00 | =
3 Basement 0,00 285 40,67 5,20 0,00 0,00
4 Bottomplate 2,85 0,30 22,56 520 0,00 0,00
5
6
P
2
Egual input in all floors
=r  Floor description
oK Cancel

If the "Active" box is checked, the corresponding load case is taken into account in the calculation of the
building bracing.
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Alternative group: See the chapter Load case. With loads due to inclination, alternative grouping also applies
to the permanent loads.

Wind With this button the standard loadcases for Wind can be generated. [ =t {$
According to the base parameters, the building geometry and wind i || allvariants
load parameters of the load case, the wind load is thereby generated I Wind W
automatically. B | Wind -Wx
With every change of the relevant wind data automatic adjustments = Wind Wy
(new generation) of the wind load are carried out in the defined O Wind -Wy

standard load cases.

All variants: With this option, several load cases with the same wind load parameters for the
corresponding wind direction are applied. If necessary, individual wind load parameters for
these load cases can be defined by use of the function "Generate Wind".

Note concerning automatic generation:

This automatic was introduced with version 3/2015. Former items are checked. If wind loads
are defined and a mismatch is detected, the user will get a notification an an automatic
adjustment is possible.

If the user rejects this proposal, the load is re-classified to a custom horizontal load. Eg. load
case "Wind Wx" is then named "Wind Wx_UserD". This user defined load case is not subject to
the automatic adjustment and remains unchanged as a general load case of the horizontal
loads. New items can be opened from former programversions

Wind (+/-)e (10%): Like "Wind", but not centered, but with an eccentricity of +/- 10%.

Inclination This button allows you to calculate inclination loads in dependence of [:g {inclination:
vertical loads in accordance with DIN 1045-1, 7.2 or EN 1992, 5.2. The SR
vertical loads are determined in a first calculation run. Subsequently, 5 HxG [}

the horizontal loads from inclination are calculated in a second run.

Hx Q

-Hx G

Earthquake This option accesses a dialog for the definition of the -Hx Q
Basic parameters for the determination of the soil acceleration Hy G

response spectrum. Hy Q

-Hy G

-Hy Q

You can generate any number of additional horizontal load cases (Buttton “New”). In this user-defined load
cases, you can freely select the direction of wind loads. For "inclined"” wind loads, an x- and y-component must
be specified separately, however.

Same input for all floors: Activate this button to assign the values of the currently active row to all other floors.

Wx  resulting horizontal force in x-direction
y distance of the resultant to zero in y-direction
Wy  resulting horizontal force in x-direction
X distance of the resultant to zero in x-direction

Tip:  You can print the graph of this dialog via the context menu options (right mouse button).

This button allows you to access the Wind load parameters dialog.
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Wind load parameters

In this section, the user can generate wind loads automatically.

Wind load parameter x
Standard : DIN EN 15%1-1-4:2010
i |
% 1
Wind zone OWZ 2 :
Terrain category : Terrain category Il "E,_y ______ —-x b
Height abowve normal h me 150 m o / B ! _L
TWY
Wind in x dir. Wind in y-dir
Hittika
Eccentricity | | | 0,00 | [mi]
Force factor 1,30 1,30 [1]
HbeWi 0,00 0,00 [m]
HAttica 0,00 0,00 [mr]
HukWi
Automatically generate wind surfaces
ﬁlK Cancel

The wind loads are generated with consideration to the defined geometry and the border conditions specified
in this dialog (Wind to x / y).

Eccentricity The user can define an eccentricity for the wind load resultant. If the eccentricity factor
is set to "0", the resultant is assumed to apply in the centroid of the floor.

Force coefficient A force coefficient of 1.30 for pressure and suction is set by default. The setting can be
edited.

HbeWi The height of the building section below ground level is specified in this section. No wind
loads are generated for this area.

HAttica The height of the roof parapet can be specified, if it should be added to the wind action
area on the top floor.

The building basic parameters (standard, MSL ...) are also shown in this dialog.
The [:] button provides access to the basic building parameters dialog.

You can find a description of the wind loads parameters in accordance with Eurocode in the
document "WL Parameter eng.pdf".

In compliance with defined criteria of bracing effects from theory Il. order can be neglected.
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Earthquake - additional option GEO-EB

» Earthquake is available as additional option GEO-EB.
I This module requires the additional option GEO-HL Horizontal loads.

Determination of earthquake loads according to DIN EN 1998-1 and DIN 4149, 6.2.2 for Germany and ONORM
B 1998-1: 2013-06/2017, 4.3.3.2 for Austria

The determination of the earthquake loads takes place according to the simplified response spectrum
method.

Access: » Input horizontal loads » Earthquake button

Tip: Note the i button in the earthquake dialog, which can be used to display additional information.
F5 key: alternative calculation of Sapr

Basic values for the determination of the ground acceleration response spectrum *

=

Standard: ‘- DIM EM 1998-1/MNA: 202107 ~ ‘ Municipality selection

dfzpotsdam.de -—b [E5] = SapR=| 1,5000 | [m/s?] spectral response acceleration in the plateau

region

Standard selection: DIN 4149 is set as the standard.

Note: Although DIN EN 1998-1 (as of January 2023) has not yet been introduced, we have implemented
this option in order to be able to carry out comparative calculations.
See also differences between DIN 4149 and DIN EN 1998-1.

The calculation is based on the simplified response spectrum method as per DIN 4149, chap. 6.2.2 or EN
1998, 4.3.3.2. According to this method, the entire system can be reduced to two plain systems that can be
examined independently of each other. It is sufficient to consider the first eigenform (basic vibration) for each
system in each direction in the examination.

A prerequisite for the application of the simplified method is a system with regular floor plans and elevations
according to DIN 4149 and EN 1998.

The regularity of the elevation is the most important condition. This means among other criteria that the
supporting walls run continuously from the foundations to the top edge of the building. Therefore, no vertical
loads on components are generated by the horizontal earthquake loading.

The calculation in the software is based on the assumption that horizontal loads are transferred exclusively
via the walls, frame supporting effects are not taken into account. Deformations by shear are not considered
either.

The requirement for a regular floor plan is less compelling and may be disregarded to a certain extent if the
prerequisites for a simplified verification of the effects by torsion in accordance with DIN 4119, 6.2.2.4.2 (2) or
EN 1998, 4.3.3.1 are satisfied.

The calculation of the participating masses is based on DIN 4249:2005, 5.5 or EN 1998, 3.2.4(2) and 4.2.4.
You should note in this connection that the relevant DIN standards require a factor of g, = 0.5 for snow loads
in Baden-Wurttemberg. A corresponding option is available in the software. Prerequisite for the enabling of
this option is a load case with the action type snow applying to any of the floors.

DIN EN 1998 prescribes a factor of g, = 0.5 for snow loads in general.
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The determination of the basic vibration times T; is based on the energy method (Rayleigh quotient with a
uniform distribution of masses). In literature, various formulas are recommended for this calculation. The

/ 0.6-m
software uses the equation T; =2.1-H- ﬁ developed by Kuttler, "Erdbebensicherheit von Bauwerken

. . i 2.n-H [m,
nach DIN 4149" (2005 edition). Alternatively, the equation T; = 7" ﬁ
(Xl . .

developed by Miller/Keintzel, "Erdbebensicherung von Hochbauten" can be used. H is the height of the
building, h the height of the floor, m the average floor mass, El the average stiffness and a; the vibration

coefficient, which depends on the number of floors.

Under normal conditions, the first equation produces slightly lower basic vibration times. The maximum
equivalent earthquake forces result from the T, value, which lies within the plateau of the response spectrum.
T1 can optionally be entered as a user value.

In the next step, the spectral values are assessed from the elastic response spectra, which depend on the
subsoil. The results depend on the respective basic vibration times.

See also DIN 4149:2005, 5.4.2, and/or EN 1998, 3.2.2.2.

You should note in this connection that taking the foremost rise in the response spectrum into account might
produce too favourable results in the calculation of the equivalent earthquake forces due to the averaging of
the masses and stiffnesses. Therefore, it is recommended using the plateau value in this area too to be on the
safe side. This can optionally be set in the program (option "no rising gradient of the response spectrum up to
Tb").

To obtain the design values of the acceleration Sy, it is necessary to divide the calculated spectral values by
the respective behaviour coefficient g, which depends on the ductility class and the slenderness of the wall.

Calculation of the horizontal equivalent earthquake forces

The total earthquake force Fy, is calculated with the help of the equation R, =S, -M-A , whereby M is the total
mass of the building and A the correction factor for the effective modal mass in the first eigenform.

The distribution of the total earthquake force over the individual floors is based on a linearly rising horizontal

Z-m
shift. The horizontal force applying at the height z results from the following equation F =F, Z— .
Z--Mm:
i

In the FRILO Building Model, the calculation of torsion is based on DIN 4149, 6.2.2.4.2, Para. (11) and/or EN
1998, 4.3.3.2.4.

The horizontal loads applying actually at the mass centroid M are assumed to apply at a distance max e or
min e from the stiffness centroid. The torsional moment MT produced this way must be distributed over the
individual walls. The more unfavourable of both values must be used for each wall.

For earthquake excitation in y-direction, the following torsional moments are obtained:
Mi=Fi-maxe=F; -(60+ e+ 62)
Mi=Fi-mine =F; -(0.5-e0- €1)

€o actual eccentricity (distance between mass centroid and stiffness centroid)
e1 random eccentricity due to the fact that the distribution of masses is unsure (0.05-L or 0.05-B)
e additional eccentricity (decoupling of the bending and torsional vibrations)
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You can handle earthquake loads in the window "Input of horizontal loads".

When considering the torsional moments, two load cases each are generated in the FRILO Building Model for
earthquake excitation in the x- and y-direction. Because earthquakes act similar to wind in positive as well as
negative direction, the button "opposing" provides for the generation of four additional load cases.

The generated load cases are automatically assigned to an alternative group for each direction.

In the FRILO Building Model, the distribution of the horizontal earthquake loads over the bracing components
is calculated. The different load cases are handled separately. The actual component verification is done in
the corresponding design application as usual. The combination of actions is also done in the design
applications.

The output profile in the output section offers a dedicated "earthquake" button, which displays a separate
dialog.

Differences between DIN 4149 and DIN EN 1998-1

Basic values for the determination of the ground acceleration response spectrum X Grundwerte zur Bestimmung des Bodenbeschleunigungs-Antwortspektrums X
Standard: | WM DIN 4149:2005-04 “ Municipality selection Map Norm: | WM DINEN 1998-1/NA:2021-07 ~ Gemeindeauswahl
: v g = mfs?] Design value of ground acceleration dfzpotsdam.de [E5] + SapR=| 0,9044| [m/s? spekirale Antwortbeschleunigung im
Samic zone: | Zone t . I Desg s Lo0ea] Mateaseraich
Buiding ground dass: | B - Baugrundklasse: | B > = 3
oo BR Subsoil relationship (combination of the dasses) BR Untergrundverhaltnis (Kombination der Klassen)
Underground dass: | R - Untergrundklssse: | R v
Significance category: | 11 P [ Significance factor Bedeutungskategoriz: | 1T . & [ Bedeutungsbeimert
Parameter for the description of the horizontal response spectrum Parameter zur Beschreibung des horizontalen Antwortspektrums
s = [1]  Subsol factor Bodenparameter
7= [l Control period of the response spectrum Kontrolperiode des Antwortspekirums
5 = [s]  Control period of the response spectrum Kentrolperiode des Antwortspekirums
Iy = [8]  Control period of the response spectrum Kontroliperiode des Antwartspekirums
¢ = [%]  viscose damping viskose Dampfung
g = [11  Behavior factor Verhaltensbeiwert
fo = [  Spectral acceleration gain
7= 1,00| [1)  Damping comection factor 7 = 1,00| [  DampfungsKorrekturbeiwert
Response Antwortspekirum
2 2
(T} %] o . . 5e(T) is?] - " -
20 0
15 15
1 | 10 E
] A7 LA
0s | os L o) P
X _—-/
E-spectrum ----- "-.._. E-Spektrum -
D-spectrum =— oo [ B-Spekirum s i) T
ool [E] [ . 0 — 001 002 01 1 1o
periarl of Dstilation [5] sthwingzeit [5]
[[no rising gradient of the response spectrum to To [kein ansteigender Verlauf des Antwortspektrums bis Th
oK Cancel oK Abbrechen

The earthquake zone known from DIN 4149, from which the design value of the ground acceleration ag
resulted, no longer exists in DIN EN 1998-1.

The coefficient of the spectral acceleration 3o is also no longer available.

You still have to choose the building ground class yourself, the subsoil class can be entered directly or set via
the municipality selection.

The seismic hazard map replaces the old zone maps. Here, the seismic hazard is shown spatially
continuously with a grid of 0.1° from geographic longitude/latitude.
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For the map display, the mean value of the amplitudes for the periods T=0.1s,0.15 s and 0.2 s was
calculated for each grid point. This value is called the “plateau spectral response acceleration” Sapr.

In the "normal case" a verification limit of S;pr < 0.6 m/s? applies. This boundary is shown as a red contour on

the map (Note: the former Zone 0 is close to this contour).

DIN EN 1998-1: the value Sapr

The value for the spectral response acceleration in the plateau area Sapr can be determined on the GFZ

Potsdam website. To do this, click on the gfz-potsdam.de link.
Here you can search for municipality names.
Tip 1:

If several communities with the same name are found, you can move the mouse cursor over the

entries in a selection list - the corresponding location is shown on the map as a blue dot.

A click on "Search" then displays the values and a diagram.
Tip 2:

When moving the mouse over the map, the coordinates are displayed (use the zoom function). You

can enter these coordinates, for example, in our alternative calculation dialog - see alternative

calculation of Sapr via the F5 key.

Alternative calculation of Szpr via F5 key

For the 0.1° grid, there are table values in the informative
digital appendix NA.J to DIN EN 1998-1, which are available as
*.csv files (download from gfz-potsdam.de). According to the
standard, the spectral accelerations between the calculated
support points may be linearly interpolated.

In the program, you can therefore use the F5 key in the Sapr
input field to call up the "Specification SaP,R" dialog and enter
the longitude and latitude here. The program then caculates
the interpolated value for the mean return period of 475 years
(file R475a_mean.csv), which you can accept.

The coordinates must be entered in decimal format. For your
information, the traditional degrees/minutes/seconds format
is also shown.

Tip: The coordinates are displayed in Google Maps if you click
on the desired location in the map display.

Specification 5aP,R >
Responsze acceleration in the plateau area of the response spectrum
(Appendix NA.| DIN EN 1998-1/NA:2021-07)

gfz-patsdam.de

Geographic coordinate of the place

DG (decimal degrees)

Latitude :
ey

GMS (degrees, minutes, seconds), informative
Latiude © | 48] |
Longitude : | g|°

43|" [3s000] " M
9| [ 38000 o

Responsze acceleration in the plateau area of the response spectrum

08347 [m/=]

S.eR -

Accept Cancel
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Involvement in the horizontal load distribution

You can select which vertical components should be
used for the horizontal load transfer over several floors.
Entire component groups such as all columns or all
masonry walls or individual components can be excluded
from the horizontal load transfer in this section.

Alternatively, you can exclude the components from the
load transfer in the properties dialog of the individual
component.

The fill colors can be individually defined for walls and
columns which do not participate in the horizontal load
transfer.

Calculation of loads

Use the "Calculate" button EE or

» Edit » Load calculation to start the load calculation of
the building.

The progress of the calculation is displayed in progress
bar diagrams.

Status / OK messages are then displayed for the
generation of the FE network and the calculation. Exit the
dialog with "OK".

=)

B-M
=-M  Wall Pier
M@ wl (
Mm@ w2 (
M@ w3 (
Mm@ ws (
M@ ws (
M@ we (
M@ w7 (
M@ we (
M@ wI (
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=M NG+2

=-M  Wall Pier
M@ w (
M@ w2 (
M@ w3 (
Mm@ ws (
M@ ws (
M@ we (
M@ w7 (
M@ we (
M@ ws

= Columns
M@ s
Mm@ s2
Mm@ s3
M & s4

i] [ Involvement at horizontal load distribution

W1.1,W1.2)
W21, w22)
W3.1,W32)
W41, W42)
W5.1,W5.2)
W6.1,W6.2)
W7.1.W7.2)
W8.1,W8.2)
W9.1,W9.2)

B W10 (W10.1,W10.2)

W1.1,W1.2)
W2.1,w22)
W3.1.W3.2)
W4.1,W42)
W5.1,W5.2)
W6.1,W6.2)
W7.1.W7.2)
W8.1,W82)

(WS.1,Ws8.2)
@ W10 (W10.1,W10.2)

B special Fill Colors | b

P

m

Tree branches

all select or deselect:

e - Walls
Walls =
Columns Columns

] [V] Reinforced concrete w

= [¥] Masonry walls

oK | Apbrechen |

Hiffe

Via the menu Options » FE mesh properties you can specify an average edge length and a minimum edge
length in [cm] for the FE elements. See also Tools » Adjustment Geometry.
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Output

The output tab provides access to the output options.

System data, results and graphics can be put out on the screen or printer.

Selection of a plan format (title block, A4 - AO, user-defined).

See output & results in program PLT.

Output settings The dialog offers comprehensive options for the control of the
output scope. Check or uncheck the desired output options for <./ Project ] Input Output
the system, the load cases, the results and superpositions.

= > Settings
[E Select layout fomat ...
Output settings

=) > Output

gl Word

Text-View

-5 CSVAile (Excel-Table)
C Load computation
I Stress amangement
I Innerforces assembly

' Main results

O Quantity survey
&= Print ...
[&, Print Preview

=)-48] XLSX-Filei (Excel-workbook)

Word Output to MS-Word, if this software is installed on the computer.

Text-View Displays the values in a text window on the screen.

You can save the contents of the text window in a csv
file via the context menu. csv files can be imported
into Microsoft Excel for instance.

Activating the F3 key displays a dialog for searching
the output text.

Searches in the output text )

Find what:

|.-’-‘n.cti0rl —ﬂ
I Case sensitiv ®  Entres delete
[ whaole words only

SYSTEM DATA

Number of floors
Admissible soil pressing

. 3 search F3

@ -
Floor SLian i

Label |3 Print Preview

RF +2 égrint... Strg+P

Roof | (54 Print Al
2. Fid

1. Flq & Export to CSV-file (Excel)

Plate

neatseach | Cancel |
= |Looking for test enter |
CSV file CSV files can be saved, for example to import into an Excel spreadsheet.
XLSX file Output of main results and/or quantity survey in an Excel file.
Print all Starts the output on the printer.
Print Preview Displays a preview of the printed page on the screen.

The functions for displaying the results graphs can be found in the chapter "Results Graphics".

Quantity survey — add-on module GEO-ME

If the add-on module GEO-ME is licensed, you can control the quantity survey via the output settings. This
allows you to define the table output individually for the individual materials and components as well as for
individual storeys or across floors. The quantities can also be exported to an Excel folder or a CSV file.
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Output Settings

The output settings dialog is accessible via the Output tab in the main menu.
You can define the scope of the output via the available options in this section.
Check system and load data, graphics and load combinations for each floor as desired. Activating the option
"equal settings in all floors" applies the settings for this floor to all other floors.
E] With the "+ E" buttons advanced detail options can be selected.

Use the buttons "General”, "Loads horizontal”, etc. to call up the output options for the respective data as
separate dialogs.

In this way, you can set your output scope in detail and individually.

Note: for quantity surveying, the additional option GEO-ME must be licensed.

Output settings x
System data and load per floor
Binding beams / Parapst wal Thickness regions
Walls =upport reguirements| Bedding regions
Geometry wallz| Bearing direction regions
Columns support requirements| Reinforcement regions
Geometry columns Loading
Plate cuntuurl Loads coord.
Floor a b [ d e f [v] i k 1 ~
1 NG+3 7 I % % T Y Y R
2 NG <2 MM O[O0 M|
3 NG+ MIM MM MM O[O0 M|
4 NG (NormaigeschoR) | ] | [ | M | A | B | M [ L1 LT LT[ 1] | b
5 W
equal setting in all floors
Load computation per floor
+E Load calculation Distribution of horizontal loads +E
Wain moments graphic Stiffening wallz / columns
+E Totals loads graphicy Strezses of the walls +E
+E Materials graphics Internal forces  4E
Wall thickness graphi Walls Columns
Floor plan | Head Foot Head Foot
[ e
Floor a b c d f a h i i k I m -~
1 NG+3 MIOEMIEI O MIHMIO[F|[EH|H]EH] M
2 NG+2 MM MMM M| M
3 NGt O M H OO RIMAIEIEF
4 NG (Normalgeschol) | (M | [T [ M D[ IMIOM{MHIM|M]| M
g L
Graphic load! Scale / Plan format equal setting in all floors
General == Instability values == Foundation ==
Loading horizontal == Quantity surveying == Earthquake =»
[ ‘ir. Eblate contour ! Recesses
oK Cancel
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Use the “Graphic load / Scale / Plan format” button to open the dialog for selecting the graphic output.

Here you select which graphics should be output (check print). The scale is set automatically by default, but

you can optionally set it yourself (column "Selected scale").

Settings for graphical cutputs

s

Fontsize : Standard-output mm
In Plan-Format mm

Top floor e
Plan-Format: A2 =
|:| Apply to all floors
2 Scale Max. Opt. Selected In ~
M Giraphaeal outpt Hi automat. Scale ScF:lIe Scale Plan-Format
1 Floor plan [ [~] 100 125 125 ]
2 Thickness walls / columns L] ] 92 100 100 ]
3 Materials of walls / columns b1 [] 82 100 100 ]
4 Totals Loads ] ] €02 100 100 ]
5 Total G-Loads b1 [] 82 100 100 ]
5 Total Q-Loads ] ] €02 100 100 ]
7 Main moments L] [] g2 100 100 ]
8 Lastfall G ] [~] 106 125 125 ]
5 Lastfall@ b1 [] 106 125 125 ]
10 Wind Wx [] [~] 138 150 150 [] W
| = |Print on/off
oK Cancel

The settings can apply to each floor or, optionally, to all floors. To output a graphic in plan format, select this

option - see also settings in settings for plan format.

In a dialog you can choose whether the instability calculation should refer to the
entire building (related to the lowest floor) or to the floors from a selected floor
(or to both). This selection is useful, for example, for buildings with different
levels of softness/stiffness.

The verifications are carried out for both rotation and translation.

Note on the output: When verifying the translation, the formula from the
standard was adapted so that the verification is calculated
against the same limit value as for the rotation.

Varying bending stiffness over the building height

The decisive bending and torsional stiffnesses of the stiffening components
combined to form the overall member are initially those of the lowest floor. In
the case of bending stiffnesses that change over the height of the building, an
equivalent stiffness is determined with the same top deformation as a result of
the unit load in the respective direction (FaxX, FakY). Jumps in torsional
stiffness cannot be taken into account. When determining the stiffness, state | is
assumed.

Options of instability values

Instability, related to:

Sum of permanent loads
total sum of loads

for the whole building
from a selected floor level

Basement

3.Floor
2.Floor
1.Floor

Basement

Cancel
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The following settings and output options are available here: Output plans X
Choice of a plan format (A4 - AO, user-defined). Shest size

Plan-Format: A3 E A3

\width: Height:

Unter Schriftgroen konnen Sie die GroRen in mm fir Standard- und 257 : 420
Planausgabe individuell einstellen. ® Portrait e Bl
Font size you can set the sizes in mm for standard and plan () Landscape \With title block
output individually.
The graphics of a selected plan format are displayed in the print preview s

via the "Plans" tab and can also be printed out here. In the overall statics
document of the FRILO Document Designer, these are attached at the end of the statics document.

£ Print preview [m] X
Document e

= jg R0 150% ~@ J@ @ Page 1 PP @~a e N Beelce] A 3  Start page: |1 Title block :
Pages Bookmarks P oot v 1 1 2 v 3 01 v 4 v 05 0 B T e B e 10 T 12 ‘D‘f"

Tip:  The "Plans" tab is only displayed if at least one graphic is selected for printing in the output profile and
the "In plan format" option is set.

Note: In this case, the entire document should be printed out on a printer that can print both formats / paper
sizes, otherwise the plan format may be printed out truncated. You can also print the pages with the
plan formats separately on a suitable printer.

For the graphics in plan format, in the FRILO Control Center FECC » Extras » Page layout » Title block
templates, title blocks can be defined, which can also be stored on a project-specific basis (as a project
property - see also the example PLT - Define title block).
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Design check in Frilo application

The "Design check in FRILO" option in the main menu provides access to the
software applications for the design of individual components or particular
verifications, if these applications are included in your software package.

Double-click on the desired application and select the corresponding component
(click on the component(s), the cursor is shown as a square). Depending on the
application, you must finish your selection with a right click and select "Exit" in
the context-sensitive menu. Subsequently, the corresponding application is
launched you can perform your design calculation there.

Slabs by Finite Elements PLT The currently active floor is transferred
to the PLT application (see Floor
selection). The live loads from the
superstructure can optionally be
transferred in a load case-specific
manner (just check the corresponding

option).

Walls by Finite Elements SCN Select a single of several connected

-~ iDesign Check in FRILO!
Slabs by Finite Elements PLT
Walls by Finite Elements SCH
Multi-storey Masonry Wall MW+
Masonry Design MWX+
Reinforced Concrete Column BS
Reinforced Concrete Column B5+
Single-span Steel Column STS+
Timber Column HO1+
Punching Shear Analysis B6+
Continuous Beam DLT
Continuous beam DLT+
Multi-span Beam Steel STM+
Reinforced Raft Foundation FDR+
Foundation FD+ FDS+ or BEB+
Soil Settlement SBR+
Pile foundation Pile+
Couplings of positions

+-F8 FE mesh

[[] Remarks
< >

walls and complete your selection with the help of the "Exit" option in
the context menu. A dialog to select the loads (total G, P and load
case-specific loads from stresses at the wall base) that should be
transferred to the panel application SCN is displayed. Click OK to
confirm your selection. The panel application is launched.

Masonry Verification MWM+ and
Masonry Design MWX+

Select a wall in the currently active floor with the help of the squared

cursor (only walls made of masonry are available for selection). In an
intermediate dialog you can select the loads to be transferred to the
design program (total G,P or load case specific).

Reinforced Concrete Column B5/B5+

launches the data transfer to the B5/B5+ application. You can also

transfer multipart reinforced concrete columns.

Steel Column STS+
Timber Column HO1+
Punching Shear Analysis B6+

Select a steel column.

Select a timber column.

Select a column, a wall end or an inner wall corner for the transfer to

B6+. In the case of a base slab, the supports that stand on the slab are

displayed after selecting this function.

The determined loads are displayed before the handover. The loads

can be adjusted here if necessary.

When the wall end and wall corner are transferred, the load
introduction length is also displayed here and can be adjusted.

For an explanation, additional information about the

determined load can be viewed via the info button.

Continuous Beam DLT/DLT+

Select one or several connected contiguous beams per mouse click.

Finish your selection with a right click and "Exit" (the application
detects automatically when all possible contiguous objects have been
selected). An intermediate dialog allows you to check the selected
objects and the load cases. Confirm your selection with OK to launch

the Continuous Beam application.

Optional: Determination of the relevant panel width according to EN

1992-1-1 point 5.3.2.1 for the design.
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Multi-span Beam Steel STM+
Foundation FD+/FDS+/FDR+/BEB+

Soil Settlement calculation SBR+

Pile Foundation Pile+

Indirect support (with downstand beams and supporting parapets) is
considered. At the point of the indirect support, a support with a
minimum spring stiffness in vertical direction is defined on the beam.

Select a steel beam to transfer to the STM+ design program.

Select the component that should be transferred to a foundation
application respectively BEB+. You can select the loads to be
transferred in the displayed dialog.

After clicking, the loads and dimensions of all foundations are
transferred to the soil settlement program. In an pre-dialog, all
foundations are listed with their column or wall affiliation before the
data is transferred.

Select a reinforced concrete column to transfer to the Pile+ design
program.

The return data from Pile+ also includes a proposal for the vertical
spring stiffness of the column, material or cross-section.

This suggestion can optionally be confirmed/accepted.

If a component is transferred from GEO to a design program for dimensioning, the item of the design program
in the building model is recorded as a coupled (linked) item. When the design program is called up again with
this component, this item is suggested for the start of the design program. Couplings that are no longer
relevant can also be removed again via the submeni » Couplings of positions. The settings for couplings can
be controlled under the menu item » Options » Coupling items.
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Multi-part column

» Design check in FRILO » Reinforced concrete column B5/B5+

If the software application detects the multipart column in the defined
building, a dialog is displayed allowing the user to select the column
sections to be transferred.

Select per mouse click a column on a particular floor that should be
transferred to the design application B5.

The software checks whether there are other columns underneath or
above the selected one.

The following criteria are taken into consideration in this verification:
1. Same material for all column sections (reinforced concrete)

2. The centroidal axes of the columns above or below run in the area
of the cross-sectional dimensions of the selected column.

Maximum number of sections: 10

Priority in the composition of multipart columns have the columns
above the selected one.

First, suitable columns are searched in the floors above (max. 10).

If the maximum number of allowed sections is not reached, the
software also searches in the floors underneath for suitable columns.
The search is aborted when the maximum number of sections (10) is
attained.

In the "Multi-part column"” dialog, the currently active floor is marked
with a dot.

Select the column sections that are not to be transferred in the graphic
shown with a mouse click:

these columns are then displayed in "blue" (deactivated).

The columns that are to be transferred are shown in "yellow".

FE mesh

i :-:- t\
H= e p
- E.-:h;zsn
d S
- :"E‘ T :1—: i
B sl 11,40
-] —~1 HF +3 1
AN
=TT "
e e &, 55
L HE FZ
| Ll
] T 5,70
bt | = Top floor i
Ehin s || =285
Column sections: SRR
connected
[ =
not M
connected -
view point @

Multipart column to the design calculation program X

Ignore loads smaller than the following absolute value

0,10 | kM)

=r |Mouse-click to set the sections on/off

0K Cancel

You can use the "Generate" submenu item to generate an FE mesh for the slab of the current floor level
(similar to PLT) - this way you can identify and correct any problems before the transfer to PLT.

The values/options set via the "FE mesh: Properties" dialog are used here.
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Additional menu items in GEO

This section describes the submenu items and functions that are not handled in the general document
Menu ltems.

Edit

Undo/Redo previous definitions and changes can be undone
Load calculation building — see chapter Load calculation

Options

Settings — GEO Building model

i Program Options x

MNaondoad bearing members OpenGL Coupling tems Interactive input Extended
Construction mode Automatic Backup Data transfer Allplan

Construction mode, Useful functions for graphical input (zoom, full screen, orthogonal,
horizontal, vertical, exit, cancel) are combined in a movable symbol
window and are therefore more readily available than with the standard
symbols above.

Non-load bearing members Selection of colors and line types for the representation of non-
structural components.

Automatic Backup, Optional activation of a periodic data backup in order to restore the
last saved position after program interruptions.

Coupling Items The connection / coupling to items in the design programs can be
switched on or off for each program.

Interactive input Background grit, axes of coordinates.

Data transfer Allplan: You can import data of partial drawings from ALLPLAN-CAD directly

into the graphic (via the shortcut CTRL-T). In order to display an
additional dialog with a list of layers, tick the option “Dialogue for the
data transfer ...”.

OpenGL, Extended The hardware acceleration for the 3D display is switched on by default.
The last window layout (size / division) can be saved by default and
appears when the program is started again.

The menu item "Customize toolbar” is hidden by default, but can be
made visible here.

Colors Settings for the use of colors for the individual components separately
selectable for screen and printer. Default: FRILO pre-defined color sets.
Save and load your own color settings.

Output setting You can define the output scope via the available options in this
section.

Basic building parameters Height above sea level MSL, standard for the load assumptions, wind
load.
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FE mesh properties

H-load distribution

Grf-Options

FE-element size settings.

See also PLT-FE network properties.

Tip: a fine-meshed FE network means longer computing times. In
phases with frequent calculation runs, it makes sense to temporarily
set a coarser network for very large buildings in order to keep the
calculation time short. The computer capacity can also reach its limits
if the network settings are too fine. If the element results are only
calculated for the center points of the elements, this also saves
computing time. The network settings are also transferred when the
data is transferred to PLT.

GEO: For single walls or for wall pillars that only consist of wall
segments of one alignment, you can optionally neglect the stiffness
about the weak axis for the stiffening calculation.

The reference of the H-force can be made either to the shear center or
the center of mass.

The H-load distribution can optionally be based on wall surfaces
instead of stiffness.

These functions are generally explained in the "Graphical Input" document.

Tools menu

These functions are generally explained in the "Graphical Input" document.
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Icons — functions - results

In addition to the standard symbols, additional symbols / toolbars are available for the specific GEO functions.

Tip: The functions of the buttons are shown in a tooltip when you point with the mouse cursor to the

button for a short time.

» see Graphical input, Input options

LI = T [(F[ W[ AP =1

» see Graphical input, chapter Loads

% 3: Loadcase 1 -

» see the chapter Load calculation

=]
EH The calculation symbol appears in the colors yellow = not yet calculated or

green = already calculated.

» see the chapter Floor selection

Icons for the various input modes

Capture function, background grid, line input, coordinate system, selection

mode

N

KKK e

» See also Graphical input, chapter Basic features of the graphical input

» see Graphical input.pdf

ETh— =@ |"@

B =)

| no support slide defines

m Building with bottomplate (Project: Bu
2" File Edit Options Layout Wind
D& (9|
z V_

i=|Floor: 2. Floor

e upper
FIl:lc-r: 2. Floor
Floor: 1. Floor
Floor Basement
Floor Bottomplate

- E

i Floor Mext lower

Hide/display an auxiliary layer, selection list to enable a particular layer, auxiliary layers management

(import/export...).
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Result graphics

-R
T The results of the load calculation can be displayed using the symbol "R" (results / summary /
rendering).
The following views of the results can be selected: __E ﬁ 1_._1 JM: | [supporting loads |v| Ij
= bearing forces (with the bearing forces along the wall axes); Supporting loads
. Head : Stresses, inner forces (walls, columns)
= stresses + cuttlng forces on the head (Wa"S and columns); F Foot : Stresses, inner forces (walls, celumns)

= tensions + cutting forces on the foot (walls and columns);

This is a load-specific presentation of the results.
The respective load case is selected via the list selection of the load cases (to the right of the "R" selection
box).

For each type of representation of the results, special interactive control elements (slidable controls) are
available in the graphic field at the top left (position movable) in the graphics window.

Tipp: Move the mouse cursor over the individual graphics elements to display the respective data in
tooltip form.
Control kontextmenu (right mouse) tooltip
\ \
Suppoithpg fosd fKN'm] Unfergeschoss : Lastfsff G : Suppoiting fosds
-26,57 |\e4o,55

S 197

Zoom
Eull Screen
v Sliders 84,2
v Headline S— » J P
 S—
v Tooltip 4
Suppositing|fosd KNS v Scale oy - -
Sum > 9945 [KNS ¥ 4 C30/37 b=20cm L=11,654m
Inscription > Distribution supporting loads [kNim ]
min: -16,83 61,66 max: 91,66
Output >
4‘ l|rs0,7
|67, 7
| 59,8 :‘ ‘ !'i

»|728,4

L1 80cm
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Il 1 /N Mat d I 56 50 kN wwm 55~ 2 6 0 4. w0 m @

Display/hide of support reactions/stresses, Load transfer from superstructure, component numbers and
dimensions of vertical components, totals of loads (wall base, column base), totals of G-loads, totals of Q-
loads, total loads in [kN], total loads in [kNm], principal moments, foundation design, individual foundations,
foundation dimensions, foundation loads, eccentricities of the equivalent earthquake force.

Result sections

Call via main selection » Result sections

This functionality makes the result sections from imported PLT items appear visible in GEO and enables the
processing and preparation of the result sections for the transfer of a storey level to PLT.

Description: See PLT - Result Sections.

Schock Isokorb /HALFEN HIT Insolation element

Determine a Schock Isokorb or a HALFEN HIT Insulation element based on
existing internal forces.

See document PLT-Schdck-Isokorb.pdf auf www.frilo.eu (in german)

Similar to the definition of a result section, a line can be defined along which a
suitable element is suggested based on the moments and shear forces.

The labeling and the optical representation of the element in the graphic can
be selected via the settings.

From Release 2022-2 2 a new version of the Schock Isokorb® program option
is integrated. The internal forces determined in PLT along the defined
connection line are evaluated via a Schéck web service. The web service is
based on the Schdck Scalix® design software and uses the input parameters
to return an economical Isokorb® installation to PLT.

Websites

https://www.schoeck.de

https.//www.leviat.com
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Note: When entering via two points, the direction of entry is important to define which side of the line

the balcony is on.
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